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Copyright 1990ï2008 Saxon Tax Software, Inc. 

All Rights Reserved  

  

No part of this document may be copied or reproduced in any form or by any means without the 

prior written consent of Saxon Tax Software, Inc.  

Saxon Tax Software, Inc. makes no warranties with respect to this documentation and disclaims 

any implied warranty of merchantability or fitness for any particular purpose. Information in this 

document is subject to change without notice. Saxon Tax Software, Inc. assumes no 

responsibility for any errors that may appear in this document.  

   

COPY PROTECTION AND COPYRIGHT  

The Tangible Tax, Florida Corporate Income Tax, Payroll Tax Program, 1120, 1120S, 1065, 1041, 

1040, 990, and Depreciation Programs, available only from Saxon Tax Software, Inc., are not 

copy-protected. This does not mean that you can make unlimited copies of them. These programs 

are protected by the copyright laws that pertain to computer software. It is illegal to make copies 

of the contents of these programs, except for your own backup, without written permission from 

Saxon Tax Software, Inc. Specifically, it is not legal to give a copy to another person.  

   

PROFESSIONAL RESPONSIBILITY  

The user is solely responsible for the accuracy of all tax returns and reports produced by the 

Tangible Tax Program, Florida Corporate Income Tax Program, Payroll Tax Program, 1120, 

1120S, 1065, 1041, 1040, 990, and Depreciation Programs. Using the program(s) does not relieve 

the user of any legal or professional obligations regarding the preparation or review of any tax 

returns of other financial reports.  

 Programs originally conceived, designed, and written by Warren H. Saxon.  

IBM is a registered trademark of 

 International Business Machines Corporation. 
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Saxon Tax Software, Inc. Software License Agreement  

  

This document is a legal agreement between you, the licensee, and Saxon Tax Software, Inc. (SAXTAX). By using this program, 

you agree to become bound by the terms of the agreement. If you do not agree to the terms of this agreement, promptly return all 

software and any other items that are part of this product with your proof of purchase, to SAXTAX and any monies you paid for its 

purchase will be refunded.  

License: In consideration of payment of the license fee, which is included in the purchase price, SAXTAX grants you a non-

exclusive, non-transferable right, without the right to sublicense, to use this copy of SAXTAX software in a single business 

location. The software covered by this license includes and is limited to all SAXTAX Programs, all user manuals, and other written 

materials provided to you by SAXTAX in connection the program(s), and all enhancements, modifications, and updates to the 

program(s), manuals, and other written materials as may subsequently be provided to you by SAXTAX. SAXTAX reserves all 

rights not expressly granted, and retains title and ownership of the software, including all subsequent copies in any media.  

Permitted Uses: This software and accompanying written materials is copyrighted. You may use the software on any number of 

computers at a single location. If you wish to use the software at more than one location, you must obtain a multi-location license 

for each location. You may copy the software for backup purposes only. All other copying of the software or written materials is 

expressly prohibited.  

Limited Warranty: If you are not completely satisfied with the software, you may return it to SAXTAX within 30 days from the 

date of receipt for a complete refund. THE FOREGOING WARRANTY IS THE ONLY WARRANTY MADE WITH RESPECT 

TO THE USE AND PERFORMANCE OF THE SOFTWARE AND IS A LIMITED WARRANTY . SAXTAX EXPRESSLY 

DISCLAIMS ANY AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMIT ED TO 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE . SAXTAX 

DOES NOT WARRANT THAT THE SOFTWARE WILL OPERATE OR FUNCTION PROPERLY ON YOUR PARTICULAR 

COMPUTER, THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT 

THE SOFTWARE WILL CONFORM TO ITS PERFORMANCE SPECIFICATIONS. SAXTAX MAKES NO 

REPRESENTATIONS OR WARRANTIES AS TO DATES OF DELIVERY. SHOULD THE SOFTWARE PROVE 

DEFECTIVE, YOU SHALL ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICE, REPAIR AND CORRECTION.  

You understand and agree that you are solely responsible for: (1) defects arising from acts of non-licensed personnel, your 

computer hardware, misuse, theft, vandalism, fire, water, acts of God or other peril; (2) the installation, use, and results obtained 

from the software; and (3) the content, calculations and accuracy of all reports and tax returns prepared in whole or in part by 

using the software. You understand and agree that using the software does not relieve you of any professional or legal obligation 

concerning the preparation or review of financial reports or tax returns.  

  

Limitation of Remedies: SAXTAXôS LIABILITY FOR ANY REASON AND UPON ANY CAUSE OF ACTION 

WHATSOEVER AND YOUR EXCLUSIVE REMEDY SHALL BE LIMITED TO, in the absence of accident, abuse or 

misapplication, the return of payment to you of the purchase price of the program(s) or the replacement of any CD, on which the 

software is distributed, that is not free from defects in materials and workmanship under normal use and service for a period of 90 

days from date of purchase. IN NO EVENT SHALL SAXTAX BE LIABLE TO YOU OR ANY THIRD PARTY, INCLUDING 

BUT NOT LIMITED TO USERS, FOR ANY DIRECT, CONSEQUENTIAL, SPECIAL, PUNITIVE OR INCIDENTAL 

DAMAGES INCLUDING, BUT NOT LIMITED TO, LOST PROFITS OR OTHER ECONOMIC LOSS (WHETHER ARISING 

FROM BREACH OF CONTRACT, TORT, STRICT LIABILITY OR OTHERWISE) ARISING OUT OF THE USE OR 

INABILITY TO USE SUCH SOFTWARE EVEN IF SAXTAX HAS BEEN APPRISED OF THE LIKELIHOOD OF SUCH 

DAMAGES OCCURRING. 



 

iv 
 

 

INTRODUCTION .......................................................................................................................... 1 

WELCOME TO SAXTAX ..................................................................................................................... 1 

HOW TO USE THIS MANUAL ............................................................................................................... 1 

INSTALLING YOUR SAXTAX PROGRAM ....................................................................................... 2 

WHAT YOU NEED ............................................................................................................................. 2 

INSTALLING FROM A CD ..................................................................................................................... 2 

INSTALLING TO THE PROPER DIRECTORY ................................................................................................ 3 

INSTALLING ON A NETWORK ................................................................................................................ 4 

STARTING YOUR SAXTAX PROGRAM .......................................................................................... 5 

STARTING THE PROGRAM MANAGER .................................................................................................... 5 

USING PROGRAM HELP ...................................................................................................................... 6 

Program Help ........................................................................................................................... 6 

Field and Forms Instructions Help ............................................................................................ 6 

USING THE PROGRAM MANAGER .............................................................................................. 7 

UNDERSTANDING THE PROGRAM MANAGER .......................................................................................... 7 

NETWORK MODULE USERS ................................................................................................................. 9 

Accessing the Network Users Screen ....................................................................................... 9 

Setting up Network Users ........................................................................................................ 9 

Files in use ................................................................................................................................ 9 

Unlocking Files/Clients (The program ǿƻƴΩǘ ƭŜǘ ƳŜ ƛƴǘƻ ǘƘŜ ǊŜǘǳǊƴύ ..................................... 10 

PROGRAM MANAGER TIPS FOR NEW SAXTAX USERS ........................................................................... 11 

Entering Preparer Information .............................................................................................. 11 

Viewing or Modifying Client Transmittal Letter Information ................................................. 11 

Viewing or Modifying Client Billing Information .................................................................... 12 

Setting up a New Client ......................................................................................................... 13 

Modifying Client Demographic Information .......................................................................... 13 

Preparing a Tax Return .......................................................................................................... 13 

PROGRAM MANAGER TIPS FOR CURRENT SAXTAX USERS ..................................................................... 14 

Transferring Client Data ........................................................................................................ 14 

Handling Corrupt Client Files ................................................................................................. 14 

Printing 1040 or Tangible Organizers .................................................................................... 15 

¦ǇŘŀǘƛƴƎ [ŀǎǘ ¸ŜŀǊΩǎ LƴŦƻǊƳŀǘƛƻƴ .......................................................................................... 16 

Creating New Clients ............................................................................................................. 16 

Preparing a Return for a Selected Client ................................................................................ 16 

USING THE MENU ITEMS IN SAXTAX ................................................................................................. 17 

The Tools Menu ..................................................................................................................... 17 

The File Menu ........................................................................................................................ 19 

The Setup Menu ..................................................................................................................... 20 

The Activity Menu .................................................................................................................. 21 

USING THE TAX RETURN PROGRAMS ....................................................................................... 22 

PREPARING A CLIENTΩS TAX RETURN ................................................................................................... 22 



 

v 
 

REVIEWING TAX RETURNS ................................................................................................................ 23 

PRINTING TAX RETURNS ................................................................................................................... 23 

BATCH PRINTING ............................................................................................................................ 24 

Returns ................................................................................................................................... 24 

Extensions .............................................................................................................................. 24 

Tangible Returns with Multiple Locations ............................................................................. 24 

SAVING CLIENT DATA ...................................................................................................................... 24 

FREQUENTLY ASKED QUESTIONS ............................................................................................. 25 

TECHNICAL HELP ...................................................................................................................... 26 

 





INTRODUCTION  

1 
 

INTRODUCTION  

Welcome to SAXTAX 

SAXTAX programs provide easy data entry, screens which closely resemble the actual 

tax forms, year-to-year client information transfer, customized transmittal letters and 

client bills, customized footnotes, on-screen review of returns, a pop-up calculator, the 

"tickler" due date monitor, and clear Program Help screens. And, of course, we provide 

unlimited toll-free technical support.  

How to Use This Manual 

This manual explains how to install and start your SAXTAX Programs. It also shows you 

how to start the SAXTAX Program Manager and the tax return programs and explains 

the various menu items. Frequently Asked Questions and Technical Help information are 

provided for additional assistance. Important notes are highlighted in shaded boxes. 

Please read these carefully.  

Names for buttons, programs, screens, dialogue boxes, tools, menus, keyboard keys, files, 

directories, and cross-references are provided in bold throughout this manual.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (800) 678-1789  
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INSTALLING YOUR SAXT AX PROGRAM  

What You Need 

The following are the minimum requirements to run your SAXTAX program:  

¶ IBM or compatible PC with 486 or greater processor 

¶ 16 MB of RAM 

 

Note: Program performance is greatly enhanced when using a Pentium level processor 

and at least 64 MB of RAM. 

 

¶ Windows 98 / 2000 / XP / NT  

¶ Hard Drive space requirements depend upon the programs installed.  

 

¶ To print forms suitable for filing, a Hewlett-Packard or fully compatible laser 

printer is required. 

 

Note: A Hewlett-Packard Laser 4+ or newer printer is recommended. 

 

Installing from a CD 

1. Insert the CD into the CD drive.  Setup should run automatically 

Note:  If the CD does not run automatically, click on the Windows Start Menu and 

select Run.  Type the CD Drive letter followed by :\Setup.  (For example, type 

E:\Setup if your CD Drive is E.)  Then press OK . 

 

2. Follow the on screen prompts.  When you are asked to enter a product code, enter 

the code you have been provided.  Setup will install program files to the 

C:\FLINT directory.  Use the Browse button to change the default. 

3. After the program files are copied to your system and installation is complete, 

you will be returned to your Windows desktop. 
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Installing to the Proper Directory 

The \FLINT directory is the default installation directory for SAXTAX programs. You 

can install to another directory, but the following should be considered.  

 

Note: Your client data files will always be located under the FLINT directory. 

 

Drive Mapping ï If you prefer to install the program files in a directory other 

than FLINT : 

¶ The SAXTAX program will create a FLINT directory to store client data 

files.  This must be a root directory on any drive. 

¶ When installing the program files in a different directory, Windows drive 

mapping may be used.  For example, to install to the C:\Apps directory, 

map this as the H:  drive.  Then install SAXTAX to the H:\FLINT  

directory.  The installation program will create the \FLINT directory. 

Setup Data ï If you install the program to the same folder or directory as last 

yearôs program, your setup data will be unchanged.  Otherwise, or if this is an 

initial installation, you will have to enter setup data on the following screens: 

¶ Preparerôs (Firm) Information 

¶ Client Bill Defaults 

¶ Network User Information (for users with Network Module only) 

¶ Client Transmittal Letter Defaults 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (800) 678-1789  
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Installing on a Network 

Your SAXTAX programs will operate with most computer network systems using a file 

server environment, including Novell and Microsoft. 

Note: Because of the complexity of networks, the SAXTAX Program Manager with 

Network Module  is strongly recommended for using the programs in a networked 

environment. 

 

Program Manager with Network Module is an optional program that makes it easier to 

use SAXTAX programs in a network environment.  The program acts like a librarian, 

automatically checking client files in and out to different users.  The program also allows 

different users to customize their own default settings for preparer (firm) information, 

transmittal letters and client bills. 

 

Note: Program Manager with Network Module ensures that only one person at a 

time works on a clientôs returns, which protects the integrity of the clientôs data.  

Installation of the programs on individual workstations while using the file server for 

client data storage will not protect the integrity of your client files. 

 

Network Installation  - You can install from a workstation or from the server itself.  Be 

sure that all workstations have identical drive mapping to the server.  If you have any 

concerns regarding the mapping, please consult your network administrator or have the 

administrator call us.  

Program shortcuts and uninstall support will be created on the installation computer. On 

each additional workstation, create a Windows Desktop shortcut ñpointingò to the file 

SAXTAX08.EXE on the server. Refer to Starting the Program Manager on page 6 for 

more information.  

 

 

 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (800) 678-1789  
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STARTING YOUR SAXTAX  PROGRAM 

Starting the Program Manager 

The Program Manager Installation Setup will  automatically create two shortcuts in the 

SAXTAX Folder under Start, Programs.  

¶ The SAXTAX 2008 Shortcut will run your SAXTAX program. 

¶ The shortcuts under the Program Help folder will access the program help 

without actually running the program. 

 

The Program Manager Installation Setup will also create a Windows Desktop 

shortcut to run the program.  Perform the following steps for any computer or 

workstation if you need to create a desktop shortcut. 

1. Using your mouse, point to a blank spot on your desktop and right click. 

2. From the dropdown list, select New, then Shortcut 

3. In the command line box, enter SAXTAX08.EXE and its path.  For example, 

C:\FLINT \SAXTAX08.EXE.  Click Next to continue. 

4. Enter the name of the shortcut (example: SAXTAX 2008). 

5. Click Finish.  The shortcut should now be on the desktop. 

 

To run SAXTAX, click the SAXTAX desktop shortcut or, click the SAXTAX 2008 

shortcut (under Start, Programs, SAXTAX). At the introduction screen, press any key 

or click to continue. The Program Manager Screen will appear. If this is the first time 

you are running the program after installation, the Program Year should be set to ô08. 

Also, when you use Program Manager for the first time, you will see an introductory 

screen to help guide you through the initial setup steps. You will only see this 

introductory screen during the initial setup.  

 

Note: Program Manager with Network Module users must enter their user ID (or 

they can use the drop down to select a user ID.  You must sign in as ñMGRò to access 

SAXTAX network management functions. 
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Using Program Help 

Program Help 

Program Help is provided for each of the SAXTAX programs, including the Program 

Manager.  Use the F1 key to access Program Help for any screen from anywhere in the 

program.  Program Help can also be accessed from each programôs Help Menu or by 

pressing the Help button found on many screens. 

Help for each program contains an Overview section and a Menu Items section. 

Use the overview section to get a general understanding of how the program works.  This 

is especially helpful for new users of the program, or for previous users starting a new 

year. 

 

From the main screen of each SAXTAX program 

Click the Help Menu 

Select Contents and click Overview to expand the 

topics. 

 

 

Other more detailed help is arranged by Menu Item. You can get 

help for all the menu items by opening the Menu Items book in 

Contents, or by going to any of the menu items in the program and 

pressing the F1 key. 

 

Field and Forms Instructions Help 

 

You can easily access field help and IRS Forms Instructions (for federal 

returns) and DOR Instructions (for state returns) from any field. Move 

your mouse pointer to any tax return input field.  Click the right mouse 

button and select Help for SAXTAX program help, or Instructions for 

Forms Instructions. 
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USING THE PROGRAM MA NAGER 

Understanding the Program Manager 

The Program Manager Screen is the ñHome Baseò for all SAXTAX Program activities. 

Use the Program Manager to set up all activities concerning clients and program utilities.  

 

 

Program Manager screen 

From this screen you can: 

¶ View Client List  in a specific drive, 

directory and program year. 

¶ Show Client List  by Entity . 

¶ Sort Client List  by Client Name, 

Type or Number. 

¶ Use Find to locate any client 

¶ See ñquick viewò client information 

¶ Use Tools, Menus, and buttons to 

access all Program Manager 

functions 

¶ See the current User ID (Network 

Module only) 

¶ Access Network Management 

functions (Network Module only) 

 

 

Note: After setting up client information, a tax return is prepared by selecting one 

client, then clicking the prepare return button.  You may also select a tax return by 

pressing the tool bar buttons right underneath the program menus. 

 

The Program Manager Screen provides lots of information.  With a quick glance you 

can see: 

¶ The active drive and directory for client data files, 

¶ The active Program Year, 

¶ A list of clients in the active directory, 

o Sort the list by client Name, Type or Number. 

o Use Find to quickly locate any client in the list. 

¶ Demographic information for the currently selected client. 
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From the Program Manager Screen you have access to: 

¶ Client Permanent File Screen (Client demographics) 

¶ Tickler Due Date Monitor 

¶ Client Data Transfer 

¶ Client Organizer activities for Tangible and 1040 clients 

¶ Client Transmittal Letter  default setup 

¶ Client Billing  default amounts and options 

¶ Client File Manangement 

¶ Preparerôs Firm Information 

¶ Tools including Rebuild Client Directory  and Calculator 

¶ Tax Return Preparation for the selected client 

¶ Batch Printing  of returns and extensions 

 

Use the pull down menus at the top of the screen to access all program functions.  The 

more frequently used functions have a Toolbar button or Push button for fast access.  

Refer to the online help for assistance and tips concerning the use of your SAXTAX 

programs.  Press F1 for help on a specific screen. 

 

Note: The SAXTAX installation program  creates a CLI08 directory  on your system 

to store your Client Data Files.  You can create additional client data directories/ 

folders on the selected drive by typing the new name into the directory box and 

pressing Enter. 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (800) 678-1789  
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Network Module Users 

Accessing the Network Users Screen 

When you run the SAXTAX Program with the optional Network Manager Module, you 

will be prompted to enter a user name. ñMGRò identifies you as the ñNetwork Managerò 

and allows you to go through the initial set-up to establish user names and default settings 

for all users.  

 

You must ñSign inò as MGR to access the Network Users Screen. Then select Network 

Management from the File Menu.  

 

Network Users Screen 

Use this screen to add, delete and 

change network users. 

All current network users appear on 

the list. 
 

 

Setting up Network Users 

The MGR can set up user ids for each of the programôs users on the Network Users 

Screen.  Each user can then customize preparer information, transmittal letters, and client 

bills. 

Note: Users should always log in with their user ID, not as MGR. 

 

Files in use 

When a user selects or ñchecks outò a client file to work on a return, the clientôs name in 

the Program Manager list of clients will be displayed in a red font. This means the client 

will be ñlockedò to all other users until the client is checked back in.  
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Unlocking Files/Clients (The program wonôt let me into the return) 

Occasionally, a program problem or power outage may cause use of the program to be 

abnormally terminated. When the program is terminated, a user may be locked out of the 

client file or directory that was in use at the time the program was terminated.  

 

To unlock client files, your Network Manager (sign in as ñMGRò) should: 

¶ Find the client file in the program manager client list 

¶ Double click the client and press ñYesò to unlock 

Any user can also unlock a file checked out to himself in the same manner. 

The Network Manager can also unlock a client by pressing the ñUnlock Filesò button on 

the Network Users Screen. 

 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (800) 678-1789  
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Program Manager Tips for New SAXTAX Users 

(If you are a current SAXTAX user, you may want to skip ahead to Program Manager 

Tips for Current SAXTAX Users on page 14.)  

Note: When you use the Program Manager for the first time, you will see an 

introductory screen to help guide you through the initial setup steps. 

Entering Preparer Information  

To enter data about your firm, choose Preparer Information from the Setup menu. 

 
Preparer Information Screen 

Enter the information 

concerning your firm.  Data 

will be saved and transferred 

from year to year.  Refer to 

Program Help for detailed 

information. 
 

Viewing or Modifying Client Transmittal Letter Information  

To view or modify client transmittal letter default information, click Setup | Transmittal 

Letters. The default letters are used as a Master letter for each clientôs tax return.  The 

letter can be tailored individually for each client, inside the return, and the modifications 

are saved with the clientôs return data.  

 

Transmittal Letter Setup Screen 

¶ Select the tab for the type of 

letter desired. 

¶ Select the part of the letter 

for viewing. 

¶ Refer to Program Help for 

detailed information 

concerning the modification 

of letters. 
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Viewing or Modifying Client Billing Information  

To view and modify client billing default information, click Setup | Client Bill.  All data 

will carry to each clientôs return ï where it can be further modified.  

 

Client Bill Defaults screen 

 

Indicate your billing preference. 

 

 

Enter billing charge for each type 

of return. 

 

Click Help or use F1 for 

additional assistance with this 

screen. 

 

Enter line item descriptions for 

each type of return.  ñVariable 

dataò insert codes are replaced 

with actual data in the final bill. 

 

You must be logged in as MGR in order to update client bills and apply to all users.  

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (800) 678-1789  

 

 



USING THE PROGRAM MANAGER  

13 
 

Setting up a New Client 

Click the New Client button to create and enter data about your client. Demographic data 

flows to each tax return. Refer to Program Help (F1 or Help button) for detailed 

information concerning the fields on this screen.  

 

New Client Screen 

You must enter a client 

number.  Use up to 6 

alphanumeric characters.  

The program uses this 

number to name your client 

data files. 

 

Tickler information is used 

to prepare Tickler Due Date 

Monitor Reports. 
 

Modifying Client Demographic Information  

Use the Edit Client Data Screen to change or modify current client data. To access the 

screen, select a client name and click the Edit Client Data button. Changes made on the 

Client Information Screen will flow to the individual tax returns only if the Allow 

Override box is unchecked.  

Preparing a Tax Return 

Note: Set the Program Year to ô08 to prepare 2008 Tangible, F-1120, and 941 returns 

and for 2007 W-2s, 1099ôs, 940ôs, Depreciation and Federal Tax Returns.  To prepare 

returns for earlier years, adjust the Program Year accordingly.   Each return allows 

you to prepare returns for the current year and 3 prior years. 

 

To prepare a tax return for a client: 

¶ Select a client from the Program Manager Client List 

¶ Click the Prepare Return button or the appropriate toolbar button to take you 

into the desired tax return or the Depreciation program.   If you have more than 

one program loaded, the Prepare Return button will prompt you to select which 

return you want to prepare. 

 

Refer to the Program Help in the applicable program for specific instructions for 

preparing different types of returns.  
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Program Manager Tips for Current SAXTAX Users 

You might want to review the activities described in the preceding section as well as the 

following:  

¶ Client Data Transfer (Rollover from prior year) 

¶ Print Client Organizers (Tangible and 1040) 

Transferring Client Data 

Your 2007 Client Data Files will automatically be transferred (or rolled over) into the 

2008 directory. However, if you do not see your company/client listed with your year set 

to ô08 in the Program Manager, you should transfer your 2007 data to 2008.  

The SAXTAX Program Manager will transfer appropriate 2007 information (i.e. 

certain schedule descriptions, Depreciation, and carryover values)  into your initial 2008 

client files. Your 2007 files will not be affected by the transfer and can be accessed by 

changing the Program Year.  

To transfer data from the most recent year to the current year (2007 to 2008) 

¶ Set the Program Year to ó08 

¶ From the Program Manager Menu, select Activity |Data Transfer .  This screen 

will show you your clients from last year and will allow you to transfer a single 

client, multiple clients and specific return types for those clients which are 

selected. 

 

Client Data Transfer Screen 

1. Use the drop down arrows to 

indicate the location of prior 

year files. 

2. Confirm the destination for 

the current year. 

3. Select specific return types if 

you are not transferring all 

returns. 

4. Select clients using Shift-

leftclick or Ctrl-leftclick or 

the Select All button. 

5. Press the Transfer Clients 

button. 
 

 

The transfer process may take a few minutes depending on the number and size of your 

client files.  You can minimize SAXTAX during this process if you need to work in other 

applications. 

Handling Corrupt Client Files  

Note: Occasionally a corrupt 2007 client file might not transfer to 2008.  If this 

happens, the transfer should skip the file and give you an opportunity to print a list of 

those clients which did not transfer. 
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You have several options for corrupt client files: 

¶ If you have your clients backed up, you may be able to copy or do a data transfer 

from your backup directory. 

¶ If it is an old client, transfer client data from 2006 to 2007 and then from 2007 to 

2008. 

¶ Create the client from scratch in 2008 inputting client information from 

documents you have on file.  This is usually quicker than the option below if you 

are doing a data transfer and most of the fields which need to transfer are 

demographic information. 

¶ Send the client files (of the corrupt client) to SAXTAX and we will try to repair 

them for you.  Under the Tools Menu, on the Program Manager Screen, is a 

Backup Clients utility which will copy various client files into a single zip file.  

You can then email us, attaching the zip file, or put the zip file on a CD and send 

it to us.  

Printing 1040 or Tangible Organizers 

An Organizer is a printed summary of last year's data that the client (or tax preparer) can 

mark up. It generally makes data entry for the new tax year easier. To print organizers for 

clients you prepared returns for last year; go to Activity | Organizers | Print Client 

Organizers.  You will also see two other options under the Organizers menu, Setup ï 

which allows you to customize the organizer letter and Blank Organizers ï which prints 

a predefined organizer for clients you have not prepared returns for in the past.  

 

Print Client Organizers 

1. Specify the location of last 

yearôs client files 

2. Select Organizer Type 

3. Select Client(s) 

4. Press the Print  button 

You can also click on the Print 

Selected Forms button to select 

specific pages you want to reprint. 
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Updating Last Yearôs Information 

If you installed your programs ñon topò of last yearôs programs, the following data should 

automatically carry over from last year. Click the appropriate Toolbar button to review 

or modify each as desired. 

¶ Your Firm/Preparer information 

¶ Client Billing defaults 

¶ Client Transmittal Letter defaults 

Creating New Clients 

To create new clients go to the Program Manager Screen and click the New Client button 

or the menu combination File | New Client. 

Preparing a Return for a Selected Client 

To prepare a return for a selected client, click the Prepare Return button or click the 

appropriate Toolbar button.  

Note: The first time you access a client that was transferred from last year, the Client 

Information  Screen will open to give you an opportunity to review and modify any 

data as necessary. 

 

 

 

 

 

 

 

 

 

 

 

For Technical Assistance, call SAXTAX at (800) 678-1789  

 

 




